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ADVANCED REPORT MODIFICATIONS

MODIFYING REPORTS

Not only does PastPerfect come with over 300 built-in reports and a Report Maker 
to create your own reports, but it also enables you to customize all of your reports. 
You can select which fields appear on reports and how they are displayed, includ-
ing the arrangement on the page, font sizes, titles, and color. You can also change 
the page setup, group records, and add calculations to reports. 

The Reports screen contains Report Layout Options that allow you to modify two 
custom layouts, rename your custom layouts, reset a report to the standard lay-
out, change the report’s description, and create a new layout for label reports. The 
screen in Figure 19-1 shows a report set to use Custom Layout 1. You may also 
activate a feature that enables you to select which layout you want to use when 
you preview or print each report. PastPerfect saves the two modified layouts and 
the standard layout.

NOTE It is important to note that when you use the Reset Selected Layout to Standard 
option, the report will be reset to the standard layout erasing any changes you have made to your 
custom layout. Your custom layout name will still appear, but your modifications will be deleted.
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To modify a report, go to the Reports menu from the Main Menu and select a 
Report Type from the left Sidebar. You will see a list of reports for that type, 
including predefined and Report Maker reports. Report Maker reports are marked 
by an asterisk. Click once on the report name from the list, choose either Custom 
Layout 1 or Custom Layout 2 and click the Modify Selected Layout button. This 
takes you to the Report (or Label) Designer screen, seen in Figure 19-2. You may 
need to enlarge this screen by clicking on the Windows “Maximize” button in the 
upper right corner. The Report Designer screen shows you the text and database 
fields that appear on the report as well as tools for customization. 

This chapter explains how to use these powerful and practical tools to get the 
reports you want, then provides some examples of common report modifications. 
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Figure 19-1
Reports 
screen

This report has 
been set to use 
Custom Layout 1.
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DROP-DOWN MENUS

File - This drop-down menu contains options to Save changes, modify the Page 
Setup and Close out of the Report Designer screen. The Report Page Setup 
screen, seen in Figure 19-3, allows you to set up multiple columns, and by clicking 
the Page Setup button, change page orientation and paper size. 

Save Your Changes - Please remember to save changes as you work by using the 
File drop-down menu Save option. And after you have modified the report, go 
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Figure 19-2 Report Designer screen

Click here to maximize the screen

Figure 19-3 
Report Page 
Setup

Click here to open the 
Page Setup screen to 
change the paper size 
and orientation.



356     PastPerfect Museum Software User’s Guide

back to File, select Close and be sure to click Yes when asked, “Do you want to 
save changes to report?”

Edit - The Edit menu has choices to Select All items in the layout as well as Cut, 
Copy and Paste selected items. You can also Undo the last performed action or 
Redo that action.

View - If you do not see toolbars when you open the Report Designer screen, such 
as Report Controls or Layout, you can use the View menu to make them available. 
Report Controls and Layout contain the most commonly used tools that enable 
you to insert labels, fields, lines, and images and change the layout. This chapter 
contains detailed information about both toolbars. The View menu also gives you 
access to the Color Palette Toolbar and Report Designer Toolbar. The Color Palette 
enables you to change the color for text, lines, shapes, etc. The Report Designer 
toolbar has shortcuts to other toolbars and report functions like data grouping. 

Format - The Format menu contains ways to align, space, and organize multiple 
items. It also accesses controls for font, color, and the weight and style for lines 
and shapes. Many of these features are available using the toolbars.

To change the font type, size, style, or color, select the text on the Report Designer 
screen and then select Font from the Format drop-down menu. You will see the 
screen shown in Figure 19-4. All Windows fonts are available. You can choose a 
style of bold, italic, or underline, a point size, and text color. You can also select 
the font color from the Color Palette toolbar available in the View menu.
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Figure 19-4
Font Change 
screen
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Report - The Report menu has selections for adding optional bands such as title 
and summary, grouping data, and choosing a default font for this report. When 
you select a default font, every time you insert a Label (capital A button) or Field 
(ab button) from the Report Controls toolbar, it appears in your specified font. 
Other options in this menu are not commonly used and are outside the scope of 
this chapter.

REPORT BANDS

The horizontal bars that span the column width of your report separate the report 
into band types. Each report contains at least three bands. The Page Header band 
is displayed at the top of each page of the report. The Detail band makes up the 
report’s body and contains output fields, and the Page Footer band is displayed at 
the bottom of each report page. In many column layout reports, the Page Header 
contains the column headings, which appear once at the top of each page. The 
Detail band has the fields that will appear for each record on the report. The Page 
Footer may include a page number or other data you want to see at the bottom of 
each page. 
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Figure 19-5 Report Designer screen with bands

The optional Title band 
has been added.
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You can add bands such as Title, Summary, Group Header and Group Footer, as 
required. The Title band contains text that appears before the main report begins. 
The Summary band contains text that appears at the end of the report. The Sum-
mary band is usually employed when you want a count or sum at the end of the 
report. The Group Header and Group Footer bands display at the top and bottom 
of each data group on the report. To add these additional bands to a report, select 
Optional Bands (for Title and Summary bands) or Data Grouping (for Group 
Header and Footer bands) from the Report drop-down menu at the top of the 
Report Designer screen. Data Grouping will be explained later in an example.

To adjust the vertical size of the various bands, click on the gray line (showing the 
band name and an up arrow) at the bottom of the band. Then while holding down 
your left mouse button, drag the line up or down to expand or shrink the band. 
You may also double click on the gray line to open a window where you may type 
in the desired size of the band.

TOOLBARS

The Report Controls, Report Layout, and Color Palette toolbars will be docked 
at the top of your Report Designer screen by default. It is easiest if you leave the 
toolbars docked at the top of the screen. Toolbars may be reshaped and moved. To 
move a toolbar that is not docked, click on the colored top portion (with the tool-
bar name) and drag it to the desired location. To dock a toolbar, drag it to the top 
of the screen so it turns into a horizontal rectangle with a thin border and let go 
of the mouse. If a toolbar does not appear on the screen, you can select it from the 
View menu. 

You will find you use Report Controls and Layout all of the time, and they are the 
ones you want to have displayed on your screen. The Report Controls toolbar con-
tains all the functions for adding and changing items including text, fields from 
your catalog, lines and images. The Layout toolbar enables you to organize those 
items. These two toolbars are explained in detail below. A Report Designer toolbar 
is also available, but you will not need to use it as its functions can be accessed 
from the drop-down menus. 
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REPORT CONTROLS TOOLBAR
Below are descriptions for each tool. 

Select Objects/Selection tool - This is the default tool on the toolbar. It 
allows you to use the mouse to select items on the report. When you are fin-

ished changing selected objects, click this arrow button to deselect them.

Label - To add or edit text in your report, such as a title, field label or column 
heading, first click on the Label tool. Next, click where you want to add or 

edit text. Once you see the flashing cursor, begin typing the text. 

Field - To add a new field to your report, first click the Field tool. Your 
mouse will turn into a plus sign. Next, click where you want the field to 

appear and hold your mouse button down. Start drawing a box with your mouse, 
and when you release the mouse, the Report Expression screen will appear. The 
Report Expression screen is described in detail below. In the Expression line, enter 
the field name for the field you want to add to the report. When you have entered 
the field name and chosen the desired settings, please click OK. On the report, you 
will see the field name in a box. This field box pulls data from the database(s) you 
selected when you chose a Report Type. 

Line - To draw a line in your report, first click the Line tool. Next, position 
the cursor where you want the end of the line to be, click and hold your 

mouse button and drag until the line is the desired length, and then release the 
mouse button. You may draw horizontal and vertical lines.

Rectangle - To draw a rectangle in your report, click the Rectangle tool. Next, 
position the cursor where you want a corner of the box to be, click and hold 

your mouse button, drag until the box is the desired size, and then release the 
mouse button.

Rounded Rectangle - To draw a rectangle with rounded corners in your 
report, first click the Rounded Rectangle tool. Next, position the cursor where 

you want a corner of the rounded rectangle to be, click and hold your mouse but-
ton, and drag until the rounded rectangle is the desired size. To indicate how 
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Figure 19-6
Report Controls 
Toolbar
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rounded your rectangle should be, double click on the Rounded Rectangle object 
to open the Round Rectangle screen where you can pick the shape of the rounded 
rectangle, from slightly rounded to completely oval. An oval shape can be resized 
to become a circle.

Picture/OLE Bound Control - Use this feature to insert an image in the 
report. Report images must be in BMP, JPG, GIF, PNG or TIF format. If you 

have your logo or letterhead as an image file, use this tool to put it on the report. 

Button Lock - Used to make one of the tools the “default” tool when insert-
ing items into a report. If you plan to use a tool multiple times, you can use 

Button Lock to save you from clicking the tool every time you need it. Click the 
Button Lock again or the Selection tool to unlock this function.

Quick Tips for Item Selection, Resizing and Placement

• Click on an item to select it.

• Click and hold down your mouse so you see a pointing hand, then drag the dot-
ted line box around several items to select them as a set.

• Shift click on multiple items to select them as a set. To do this, please hold 
down the Shift key while using the mouse to click on multiple items.

• When items are selected, you can move them with the mouse or the arrow 
keys on the keyboard. You may also resize them using your mouse or by hold-
ing the Shift key down and using your arrow keys. 

• When multiple items are selected, you can resize them together by holding 
down the Shift key and pressing the arrow keys.

• Double click on items to open screens that let you change their attributes.

• When you are finished changing selected items, click the Select Objects/Selec-
tion tool on the Report Controls toolbar to deselect them.

• To adjust the vertical and horizontal location of an item, click on the item and, 
using the left mouse button, drag it up or down. You can also click on the item 
once to select it, then press the keyboard arrow keys to move it.
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THE REPORT EXPRESSION SCREEN
When adding a new field to the report, use the Field tool, as described above. This 
will open the Report Expression screen, seen in Figure 19-7. This screen can also 
be used to change an existing item’s attributes. To open the Report Expression 
screen for an existing item, double click on the field. 

For most reports, you can add any field that is contained in the database on which 
the report is based. For a list of available fields, please review the Field Descriptions 
reports from the Reports menu. The field name that you enter in the report expres-
sion is not always identical to the field label on the data entry screen. When viewing 
the Field Descriptions report, the field name comes after the paragraph, inside square 
brackets before the colon. For instance, “objname” is the field name in [OBJNAME: 
c(40)]. To add the Object Name field to the report, type objname in the Expression 
line. If a field name is added to a report that is misspelled or not contained in the 
underlying data file or query, the report will produce errors. 

You may enter one or more field names in an Expression line. If you want to pull 
multiple data fields into one field box, you will separate the field names with a 
comma or semicolon with NO spaces. If you use a comma, the fields will appear 
with one space between them in the report. When using a semicolon, a carriage 
return will appear between fields. 

Example: If you had a Contacts report where you wanted the first column with the 
contact ID#, a second column with contacts’ first and last names, a third column 
with the last donation date, a fourth column with the last donation amount, and a 

Figure 19-7
Report 
Expression 
screen

Enter the field name here.

Choose field position, usually “Float.”

Check here if you want the 
field data to continue on more 
lines as required by the length 
of that data. 



362     PastPerfect Museum Software User’s Guide

fifth column with both the home and cell phone numbers, you would insert field 
boxes as in Figure 19-8. You can place the fields first name and last name together, 
separated by a comma in one box like this: firstname,lastname. 

They will appear in one column as shown in Figure 19-9. You also want the tele-
phone numbers in a single column, but want home phone to appear above the cell 
number. You can achieve this by entering phoneh;phonecell in the Expression. 
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Figure 19-9 Preview of report

First name and last 
name are separated 
by one space.

Home phone and 
cell phone are on 
separate lines.

Figure 19-8 Report Expression screen

Enter fields “firstname” 
and “lastname” separated 
by a comma.
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Using the Format option on the Report Expression screen, you can left, right or 
center justify data in a field box. For instance, if you include a field like amount 
paid (which represents a monetary value), you may want to right justify the num-
bers on the report. You can do that by clicking the Browse button (button with 
three dots) to the right of Format, unchecking Left Justify, and selecting Right Jus-
tify. Click OK. 

In the Field Position section of the dialog screen, you can set whether an item is 
fixed to a point in the report or floating relative to other items. You generally want 
to use Float when you have Stretch with overflow selected. If the data in one field 
may stretch to multiple lines, as is often the case with unlimited memo fields, you 
will want other fields and text to move up or down, rather than being overwrit-
ten. For instance, your object descriptions may be several paragraphs or just a 
sentence. You would use Stretch with overflow to allow one field expression box 
(descrip) to accommodate different description lengths. You would then also set 
the description field box and other field boxes and text labels around it to Float. 
This way the position of the items accommodate longer and shorter descriptions. 

When you place a field on the report you should adjust its size to the minimum 
required, not the maximum. Using Stretch with overflow enables you to compen-
sate, so that all data appears on the report, even if the field expression box does 
not seem large enough. Data will flow to additional lines.  

TIP Some reports are set up as labels, such as catalog cards, catalog record labels, and con-
tacts mailing labels. Working in the Label Designer screen is just like using Report Designer; how-
ever, your fields, labels, lines, etc. must have a fixed field position due to the limited size of labels. It 
is also important to note that fields on labels may not be set to Stretch with overflow. They will have 
a fixed size.

With the Calculations tool, you can count the number of records or get a sum of 
values on reports. Many of the predefined reports show a count of the records 
or contain total values. However, you can add these to any report by inserting a 
Summary band, copying a field, and setting the Calculations. 

Counting Records on a Report

To count the number of records on a report and place the total at the end of the 
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report, first go to the Report drop-down menu at the top of the Report Designer 
screen. Choose Optional Bands and check Summary band, seen in Figure 19-10. 
Click OK. 

Since there is one Object ID field for each record, you can count the number of its 
instances to get a total number of records. Select the objectid field and go to the 
Edit menu. Choose the Copy option. Then choose Paste. Using your mouse, move 
the second objectid field box down to the Summary band, as in Figure 19-11. 

Double click on the objectid field to display the Report Expression screen then 
click Calculations as seen in Figure 19-12. Select Count and click OK twice to exit 
the Report Expression screen. 

The total number of records will appear in this field box on the last page of the 
report. You may want to use the Format drop-down menu and choose Font to 
make this box bold. You can also use the Label tool to add text to explain this 
number.
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Figure 19-10 Optional Bands screen

Check the Summary band 
box to add a Summary band 
to the report.
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Summing Values on a Report

When choosing a field to sum, please keep in mind it needs to be a numeric field 
to perform the calculation. Generally numeric fields, such as objects’ acquired val-
ues or insured values or contacts’ donations, dues, or in-kind gift amounts, are the 
fields that you want to sum. To get a total value on a report, start the same way as 
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Figure 19-11 Report with objectid in Summary band

Objectid field in the Summary band 
with “Total Count” label added.

Figure 19-12
Calculations 
screen

Click Calculations to 
open the Calculate 
Field screen.

Select Count.
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counting records, by creating a Summary band. Then, similar to counting records, 
select the field you want to sum, and copy the value or amount field and paste the 
copy into the Summary band. This is where the total value will appear at the end 
of your report. Double click on the field box and click Calculations. Choose Sum, 
as seen in Figure 19-13, and click OK twice. 

Print When Statements

The Print When function allows you to remove a line if no data exists in that field 
or print data only if a condition is met. One of the most common uses is in address 
labels. Some contacts may have two address lines, so you want to add both the 
Address1 and Address2 fields. However, you do not want an empty line if no 
data exists in the Address2 field. To eliminate the empty line, double click on the 
address2 field box. Click Print When, then check Remove line if blank, as in Fig-
ure 19-14. 

Click OK, then OK again to exit the Report Expression screen. Now when printing 
a list of contacts labels, the city, state and zip code line slides up beneath Address 
1, when no data exists in the Address 2 field. 
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Figure 19-13 Calculate Field screen, Sum selected

Click on Sum.
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Print When may also be useful if you use numeric fields and want the data to 
print only if the amount is greater than zero. Double click on the field containing 
the data you want to restrict, then click on Print When. In the Print only when 
expression is true box, enter the field name, the greater than sign and zero. For 
example, if you wanted to print only the current minimum values for items with 
values greater than zero, you would enter the following, seen in Figure 19-15.

Then click OK twice to get back to the Report Designer screen. 
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Figure 19-15
Print When 
screen with 
expression

Enter expression here.

Figure 19-14
Print When 
screen

Check the Remove 
line if blank box.
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THE LAYOUT TOOLBAR
The Layout toolbar can be quite helpful to ensure that items on the report are 
properly aligned or centered. For example, to be sure that the left edge of multiple 
items are aligned, select the items with the Selection tool and click the Align Left 
Sides button. 

The Layout toolbar has 12 other tools, including Align Right Sides, Align Top 
Edges, Align Bottom Edges, Align Vertical Centers, Align Horizontal Centers, 
Stretch to Same Width, Same Height, Same Size, Center Vertically, Center Hori-
zontally, Move to Front, and Move to Back.

EXAMPLES

Now that you know the basics, here are a few examples of report modifications. 
The important part of these instructions is the process, which you may apply to 
any report.

For the first example, let’s say you want to modify the Objects Summary report to 
include more information. The default report includes these fields: Catalog (O, P, 
A, L), Object ID, Object Name, Description, Condition, Status, and Home Location. 
If you want to remove the fields Condition and Status and add the fields Other 
Name and Collection to the report, follow these steps. 

MODIFYING FIELDS AND TEXT

1. From the Reports menu, select Objects from Report Types and click once on the 
report Objects Summary. 

2. From the Report Layout Options section, choose Custom Layout 1 or Custom 
Layout 2 and click on the Modify Selected Layout button. This will open the 
Report Designer screen.
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Figure 19-16
Layout Toolbar

Align Left Sides button
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3. Now let’s change the Condition field to Collection. To do this, double click on 
the field “Condition” which is in a box above the gray band labeled Detail. In 
the Report Expression screen, change the Expression from Condition to Col-
lection and click OK. 

4. Next, you need to change the label for the field as it appears in the Page Header 
band. To make that change, select the Label tool from the Report Controls 
toolbar, click on the word “Condition,” use backspace and/or delete on your 
keyboard, then type the text “Collection.” Then click the Select Objects tool to 
complete the change.

5. Now, to make more room for the Collection field, let’s remove the Status field. 
First click on the word “Status” in the Page Header band and press the Delete 
key on your keyboard. Then click on the field status in the box below in the 
Detail band and press the Delete key again.

6. With the extra space available to the right, you can expand the width of the Col-
lection field to accommodate longer entries. To do this, first click on the Col-
lection field box in the Detail band. When it is selected, you will notice that the 
box has eight small dots, one each on the four corners and in the center of each 
side, as in Figure 19-18. 
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Figure 19-17 Change Expression

Change “condition” 
to “collection.”
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 To increase the width of the field, point the mouse to the center dot on the 
vertical right edge of the field. You will see your mouse cursor change to a 
vertical line with arrows pointing to the left and right. Press and hold the left 
mouse button while you drag to the right. When it reaches the desired width, 
release the mouse button, seen in Figure 19-19.

7. The last step is to add the Other Name field. We want to have the Other Name 
print in the left column of the report, below the Object Name. To do this, 
double click on the field cat,objectid;objname in the Detail band. In the  
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Figure 19-18 Selected field

Collection field 
is selected.

Figure 19-19 Field expanded

Collection field 
is expanded.

Figure 19-20
Expression 
field

Enter expression of: 
cat,objectid;objname;othername
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Expression field, after “objname,” add a semi-colon and the word othername. 
See Figure 19-20. 

 When you print the report, you will see the catalog, a space, the Object ID, a car-
riage return, the Object Name field, a carriage return, and the Other Name field. 

8. Since there is not much space in the Page Header to add the words “Other 
Name,” select the Label tool, click on the text “Catalog/Objectid/Objname” 
just after the “e” and add an “s.” This will change the field label to “Catalog/
Objectid/Objnames.”

9. Finally, save your changes by selecting Close from the File menu and answer-
ing Yes when asked, “Do you want to save changes to report?”

Now you can run the modified report from the Reports menu. Be sure that the 
report is set to the Custom Layout you selected, under Report Layout Options. 
You can narrow the records to include by selected fields, sort the results, and pre-
view or print the report. Figure 19-21 is a preview of the modified Objects Sum-
mary report.

Figure 19-21 Modified Objects Summary report
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ADDING IMAGES ATTACHED TO CATALOG RECORDS
With PastPerfect it is also possible to include images on a report. In this example, 
we will add the image of each item to the Collection List with Descriptions report.

1. First, open the design screen by selecting Reports | All 4 Catalogs, and Collec-
tion List with Descriptions. Select a Custom Layout, then click Modify Selected 
Layout. 

2. Let’s place the image on the left of the report just below the alltrim(descrip) 
field box. You will need to increase the height of the Detail band to accom-
modate the image. Click on the gray Detail band and drag it down to make 
the space. Then select the Picture/OLE tool on the Report Controls toolbar and 
move your cursor to the blank area where you want to place the image. You 
will notice your cursor is a plus sign. Click and hold your mouse button down 
and draw a box. 

3. As soon as you release your mouse, the Report Picture screen will open, which 
allows you to specify the filename of the digital image. Since we want to add 
images that have been attached to PastPerfect records, we will use a specific 
expression. In this case the entry would be as follows:

 printimage(alltrim(imagedir)+alltrim(imagefile))

 Be sure to select Scale picture, retain shape as shown below. 
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Figure 19-22
Report Picture 
screen

Choose Scale picture, 
retain shape.

Choose Float.
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4. You will also need to use the Print When function, in case there are records 
without images on the report. Click the Print When button, then in the Print 
only when expression is true line, enter the following expression.

 !empty(imagefile) and file(alltrim(imagedir)+alltrim(imagefile))

5. Click on OK to return to the Report Picture screen. Please be sure the image is 
set to the Object Position Float. Click OK to return to the design screen. You 
should now see a gray box with an “X” on the screen where the image will be 
placed, as in Figure 19-23. You may need to adjust its size by clicking on the 
selection dots on the edges of the image and dragging one of the corners. 

6. This report has alternating gray and white backgrounds for records. You will 
need to expand the gray rectangle that exists behind the field boxes so that 
it encompasses the image box you added. Click on the gray rectangle just 
beneath the field boxes to select it. Then left click on the selection dot in the 
center of the bottom edge. When your mouse is in the right place, you will see 
arrows pointing up and down. Hold your left mouse button down and slide 
the bottom of the gray rectangle down.

7. Using your mouse, drag the Detail band up so it is just underneath the gray 
background rectangle. The report should look like Figure 19-24.
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Figure 19-23 Report layout with image

Image will be here.
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8. From the File menu, choose the Close option and answer Yes when asked, “Do 
you want to save changes to report?” Be sure that the report is set to the Cus-
tom Layout you selected under Report Layout Options (Step 1). 

Figure 19-25 is a preview of the report with the catalog image added. 
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Figure 19-24 Finished modified Collection List with Descriptions report layout

Figure 19-25 Preview of modified Collection List with Descriptions report
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ADDING A LOGO IMAGE
You may want to add your organization’s logo to the Title or Page Header band of 
reports. Here are the steps for adding a logo image located on your hard drive to 
the Deed of Gift report.

1. From the Reports menu, select Accession from Report Types and click once on 
the report Deed of Gift. 

2. From the Report Layout Options section, choose Custom Layout 1 or Custom 
Layout 2 and click on the Modify Selected Layout button. This will open the 
Report Designer screen.

3. Enlarge the Report Designer screen to full size by clicking on the Windows 
Maximize button in the upper right corner. This is the center button between 
Minimize and the X for Close.

4. Left click on the Picture/OLE Bound Control tool in the Report Controls toolbar 
and move your mouse to where you want the logo. Your cursor will be a plus 
sign. Holding your left mouse button down, drag your mouse to start draw-
ing a box. As soon as you release your mouse, you will see a new window, the 
Report Picture screen.

5. Use the Browse button (button with three dots) to the right of the File field to 
get to the Open screen where you can navigate to the logo image on your hard 
drive. Locate the image, then select it and click OK.
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Figure 19-26
Report Picture 
screen

File field has location of 
image on the hard drive.
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6. Choose Scale picture, retain shape at the Report Picture screen (Figure 19-26) to 
keep your desired image size and retain the image’s proper proportions.

7. Click OK to exit the Report Picture screen. You should see your logo image. You 
may enlarge or shrink the image using one of the selection dots at the corners. 

8. From the File menu, choose the Close option and answer Yes when asked, “Do 
you want to save changes to report?” Be sure that the report is set to the Cus-
tom Layout you selected under Report Layout Options. Figure 19-27 is a pre-
view of the report with the logo image added.

DATA GROUPING
By grouping records on your report, you can view certain objects or contacts 
together as a subgroup and perform calculations on the subgroups’ fields. Let’s 
say that you want to find the total number of photographs kept in each storage 
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Figure 19-27 Preview of report with logo image
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box to estimate the number of acid free photograph boxes you need to order as 
you process the collection in the coming year. To do this, we will first create a 
simple Photos Report Maker report, then modify its layout to group by the field 
Home/Container, which is the sixth location field. For detailed information on 
creating Report Maker reports, please see Chapter 18 - Report Maker.

1. Choose Report Maker from the Main Menu.

2. Choose the Photos Report Type and click Create New Report.

3. Enter a Report Name, such as Photos Box Count, complete the other fields as 
needed and click Next.

4. In the Build Filter Statement screen, select the field Object ID from the drop-
down menu.

5. From the Condition drop-down menu, select Is not empty, click Add to State-
ment, then click Next.

6. At the Fields to Include screen, double click on the Object ID field from the list 
on the left. It will be added to the Fields to Include on Report. Also select the 
Home/Container field. Click Next.

7. At the Select Sort Order Fields screen, choose to sort by the Home/Container 
field. Double click to move the field to the Fields to Sort by column. Click 
Next, then click OK.

8. Exit from the Report Output Options screen. When asked if you want to save 
this report, click Yes. Then Close out of Report Maker Reports.

9. From the Main Menu, choose Reports, then the Photos Report Type.

10. Click once on your Report Maker report *Photos Box Count. Select Custom 
Layout 1 or Custom Layout 2 and click Modify Selected Layout.

11. Maximize the Report Designer screen, then click the Report drop-down menu 
and choose Data Grouping.

12. In the first box (with opposing arrows to its left), seen in Figure 19-28, type the 
following and click OK:

 locfield6
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13. You will see two new bands – Group Header 1: locfield6 and Group Footer 1: 
locfield6. Pull the Group Header band down to accommodate a field box.

14. Using your mouse, move the locfield6 field box into the Group Header band, 
along the left side. You may want to delete the Object ID label in the Page 
Header band. You can do this by selecting it with your mouse and using the 
Delete key on the keyboard. Then move the Home/Container label to the left, 
above the locfield6 field. 

15. Pull the Group Footer band down to accommodate a field. Using your mouse, 
move the objectid field box from the Detail band to the Group Footer band, 
along the left side, as in Figure 19-29.
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Figure 19-28 Data Grouping screen

Enter group 
expression here.
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16. Double click on the objectid field box and click Calculations. Choose Count 
and click OK twice to get back to the Report Designer screen.

17. Delete the gray rectangle in the Detail band and pull that band up against the 
Group Header.

18. Click the File menu and choose Close. Be sure to save your changes. When you 
run and preview or print the report you will see a report with the box names 
and the number of items in each box. See the preview in Figure 19-30.
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Figure 19-29 Report Designer screen

locfield6 in the Group 
Header band.

objectid in the Group 
Footer band.

Figure 19-30 Preview of Photos Box Count report

Report lists each box, then the 
count of items in the box.
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TIP If you modify a predefined report to include Data Grouping, when running the report, you 
must choose the field for your Sort Order that you used to group your data. Otherwise the data will 
not be grouped properly.

CREATING A NEW LABEL LAYOUT
The PastPerfect Reports screen can be used to print and design labels. Some exam-
ples of labels are mailing labels, catalog cards, spine labels, and barcode labels. 
Modifying labels is similar to modifying reports, with a few exceptions.

When you select a label from the Reports menu and choose a Custom Layout, an 
extra button is available in Report Layout Options. This button is named Create 
New Label Layout and will allow you to select a label design from a list of stan-
dard Avery labels. By clicking this button, you erase any customization you previ-
ously added, and create a new blank label. 

Here is an example of how to design a Contacts mailing label using a new label style. 
By default, Contacts Label Style #1 and Style #2 both use Avery labels #5160, which 
measure 1” x 2 5/8” and print in three columns on the sheet. We will modify Label 
Style #2 to print on Avery labels #5163, which are 2” x 4” and print in two columns.

1. First, select Contacts and Contacts Labels Style #2 from the Reports menu. 
Then click on Custom Layout 1 or Custom Layout 2.

2. So that you will not have to re-create the fields on the new label, you can open 
the old design, select the fields and use the cut and paste tools to transfer 
the fields. To do this, click on Modify Selected Layout to display the Label 
Designer screen. Click on Edit | Select All, then Edit | Copy. This will put the 
fields in the Windows Clipboard. Click on File | Close to return to the previ-
ous screen. It is not necessary to save the changes.

3. Now, click the Create New Label Layout button. When asked if you want to 
erase the custom label and start a new one, click Yes. You will be presented 
with a list of label styles and their associated Avery numbers, seen in Figure 
19-31. Select Avery #5163 and click OK.
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4. The new blank label design screen will open. Make sure that the gray Detail 
band is set to 2” and the label width is 4”. Click on Edit | Paste to transfer the 
fields from the Windows Clipboard to the label. You will probably need to 
rearrange the fields to fit this larger label. 

5. Finally, select File | Close and save your changes. Now when you use the cus-
tom layout selected for Contacts Label Style #2 you will get the new layout.
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Figure 19-31
New Label 
selection 
screen

Figure 19-32 New Label screen
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